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Introduction 
Fontographer makes it easy to create new typefaces or add your logo to existing 
typefaces. Fontographer’s drawing tools help you create a professional-quality 
character in minutes and print that character on any PostScript or TrueType 
compatible printer. With Fontographer and your personal computer, you can 
create designs that match those produced by professional typographers. 

Fontographer 5 generates ATM-compatible Type 1 fonts, as well as Type 3 
PostScript fonts, TrueType fonts, OpenType fonts and multiple masters on the 
Macintosh, and Encapsulated PostScript (EPS) files. You can import EPS files 
directly, and use their outlines in the drawing window. You can also use metrics 
information from a variety of sources, and export information to those sources as 
well. Additionally, you can import kerning tables from Adobe Font Metrics (AFM) 
and other files. You can also take advantage of the PostScript graphics you create 
in FreeHand and Adobe Illustrator by pasting them directly into your characters. 

Many dialog boxes in the program give you two options: Easy and Advanced 
mode – letting you have total control of the program if you want it, or allowing 
you to rely on its simple and automatic settings. 

For advanced users who don’t always want to rely on automatic hint settings, 
there is a menu of hinting controls. And in the Metrics arena, Fontographer lets 
you space and kern faster and easier than ever. With auto space, auto kern, and 
assisted kerning and metrics you can save yourself from having to kern and space 
each individual character or font separately. Fontographer can do it automatically, 
or you can use the same kerning and spacing information from one font, for others 
that kern and space similarly. 

So whether you are a novice or an experienced graphic designer, Fontographer 
allows you to assign your characters and graphic images to any key or 
combination of keys, and gives you the added ability to instantly repeat and resize 
these images in any application. 
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Getting the most out of your 
Fontographer materials 
This version of the Fontographer User manual is designed for Macintosh users 
of Fontographer 5 only. If you have Fontographer 4.7 for Macintosh you need the 
previous version of the manual. 

We placed keyboard alternatives after certain menu commands; get into the habit 
of using these quick commands that our more experienced users prefer. 

The Fontographer User manual assumes that you are familiar with the computer 
and that you have a working knowledge of how your system operates. If you need 
more information on these topics, refer to your Macintosh owner’s manual. 

We don’t have a separate tutorial. Ours is included right in this Fontographer 
User manual. Tutorial icons are interspersed throughout the manual. 

  Tutorial icon 

If you are a first-time user, the best way to start learning Fontographer is to use its 
tutorial. Ours is a novel approach to tutorials… but we think you’ll enjoy this new 
method of introducing you to Fontographer’s basics. 

The tutorial icon appears next to exercises in some chapters. We’ve also placed 
icons next to text you should read before you start the exercise itself. We strongly 
recommend that you work your way through the tutorial exercises in order. 

The tutorial is meant to be a guide to give you practice using some of 
Fontographer’s standard features. It does not cover all features, nor even most of 
them, but should be used as a starting place, if you are unfamiliar with the 
program. 

Once you have completed the tutorial exercises, review the rest of your 
Fontographer User manual for information that will help you plan and create 
your fonts. 
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System requirements 

If you are using the Macintosh version of Fontographer 5, you must have a Power 
PC or Intel-based Macintosh computer running Mac OS X 10.4 or later operating 
system with 15 MB of hard drive space, and at least 50 MB of available 
RAM. Fontographer 5 is a universal binary application which means it has code 
for both Intel and Power PC processors. It’s also a good idea to make sure you 
have the latest version of Apple’s System update for your machine. 

You must purchase additional copies of Fontographer in order to run more than 
one copy at the same time. For additional copies, contact Fontlab Ltd. at 
orders@fontlab.com or your nearest Fontographer dealer. 

Support 

For further information about Fontographer browse to the Fontographer home 
page: 

 http://www.fontlab.com/fontographer/ 

Use the following address to get Fontographer updates and upgrades: 

 http://www.fontlab.com/support/ 

In case of any questions or to report possible bugs in Fontographer or any other of 
our products browse to: 

 http://www.fontlab.com/support/ 

The Fontographer technical notes collection is available for download (in PDF 
format). Technical notes address various issues and problems concerning 
Fontographer 4.x: 

 http://www.pyrus.com/downloads/FG4Technotes.pdf 
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Basics 
If you’re a professional typographer, Fontographer offers you tools you can use to 
create professional typefaces. You can use Fontographer as a drawing tool, not just 
as a font editor. Create logos quickly and easily, just like with a drawing program, 
or scan any image from a book or other source and let Fontographer auto trace it. 
Metric tools, including automatic kerning, spacing, and metric tables help you 
create a consistently spaced and kerned font faster than ever before. 

If you’re a novice, Fontographer gives you the tools you need to quickly create and 
change fonts without intensive study and practice, plus the opportunity to 
increase your skill to a professional level. 

 

Create glyphs from scratch 
or by autotracing a scanned image. 
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Setting preferences 
Fontographer 5 automatically places a preferences file in the user's 
Library/Preferences folder called Fontographer 5.0 Prefs. To set preferences, 
choose Preferences from the Fontographer menu. See “General preferences” in 
Chapter 13, “Expert Advice”, for more information. 

 

Platform consistency 

These two options define how Fontographer behaves when it needs to import, 
calculate and export different linespacing font values. Unless you do not need this 
for some special purpose leave the first option selected. This will keep linespacing 
in your font the same for all platforms and applications. 
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Undo 

Use the Preferences dialog to select the number of Undo commands you want to 
allow. Choosing Undo from the Edit menu will undo the last command. You can 
undo up to 100 commands using Fontographer’s default setting or change the 
number of undo levels in the Preferences dialog box. The maximum number of 
undo levels allowed is 256. The more undo levels you allow, the more memory you 
use, and the less you have for the font you’re editing. Fontographer will 
automatically throw away undo levels when there isn’t enough memory. Surely 
this is only actual for older systems with low RAM available. 

Editing 

To set Preferences related to editing behavior, choose Editing in the header of the 
Preferences dialog box. 

Smooth outline 

This setting lets you to select between non-anti-aliased and anti-aliased rendering 
of the outline. It doesn't influence the generated font but only the screen preview. 

  

smoothing is off smoothing is on 

Cursor-key distance 

This preference setting lets you set the distance the arrow keys will move a 
selected object (in em units) when they are pressed. If you press an ARROW key 
while holding down the OPTION key, the distance the object moves is divided by 10; 
if you press an ARROW key while holding down the SHIFT key, the cursor distance 
will multiply by 10. 



Fontographer 5 

20 

For example, the following images show the effect of using the ARROW keys to 
move selected objects. In the first example, the ARROW key is used by itself, 
moving the starburst 10 em units closer to the bar. In the second example, the 
starburst is moved with the ARROW key and the SHIFT key held down, making the 
distance 100 em units. Holding down OPTION-ARROW key divides the value by 10 – 
making it one em unit. 

  

Grid spacing 

There is an invisible key grid in the outline window that can be used to position 
glyphs. When you choose Snap to Grid from the View menu, SHIFT-COMMAND-I, 
any objects you move will automatically snap to the nearest grid. 

You can change the distance between grids from one em unit to another distance. 
The Snap-to distance represents the distance at which an object will snap to a grid 
intersection. The Snap-to distance preference is entered in screen pixel units. The 
window’s current level of magnification will affect how this operates. 

 

Set the cursor distance, grid spacing, and snap-to distance. 

Ü Tip: Listen to your snaps by turning the application sounds on in the General 
preferences. 
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Point display 

The Point display dialog box contains several options for viewing points. Decide 
whether you want to view large or small points, Bézier control point (BCP) lines, 
or just BCP points. You can highlight the path origin, or the ends of unclosed 
paths. You can also highlight adjacent overlapping points or points on a path you 
are dragging. 

 

Labels can be shown for all points or only for selected points and BCPs (numbered 
or lettered in sequence). Or you can show the x and y coordinates for each point or 
for selected points only. 

Fontographer will use the default settings unless you choose otherwise. 

Windows and dialog boxes 

Preferences lets you set the placement of windows, remember values and positions 
of dialog boxes, control how glyphs fit into windows, and have palettes move with 
the windows. 

For more information about setting any of the preferences, see “General 
preferences” in Chapter 13, “Expert Advice”. 
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The UPM size 
Each glyph fits into a rectangle called an em square. An em square is usually a 
square the size of a capital letter “M”, which extends to the descender line so it is 
also called UPM (units per M). The em square received its name from the capital 
“M” that filled the piece of metal used to form the type body in early printing days. 
The font’s height is determined by the distance between the ascender and 
descender. All fonts are normalized inside the printer, at an em square one point 
(approximately 1/72 inch) high. Defining a font in this fashion allows a single 
outline to be scaled to any size requested. Think of UPM units as relative 
coordinates rather than as specific physical distance. 

Refer to the figure below as you follow the overview. 

 

 

! Note: The ascender and the descender in “Ship” lie at the top and the bottom of 
the em square, respectively. This may not always be the case. 

Ascender 

A font’s maximum distance above the baseline is called its ascender. Fontographer 
automatically places an ascender guideline in the outline window at the top of the 
em square (UPM size). You can change it by choosing Font Info from the Element 
menu. 

Ü Tip: Glyphs in Type 1 fonts normally should not extend above the ascender line. 
Any glyph that extends above the ascender line or below the descender line may 
have its bitmap representation vertically scaled to fit between the ascender and 
descender. See “When should you recalculate bitmaps?” in Chapter 5, “Editing 
Bitmaps”, for more information. See also Safe zone top and bottom values. 

Ascender 
Cap height 

x-height 

Baseline 

Descender 
Width “i” 
Origin “p” 

Origin “i” 
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Descender 

A font’s maximum distance below the baseline is called its descender. 
Fontographer automatically places a descender guideline at the bottom of the em 
square (UPM size) in the outline window. The descender line lies at the lower 
vertical position specified when you created the font. You can change this setting 
by choosing Font Info from the Element menu. 

Ü Tip: Usually glyphs do not drop below the descender line or they may interfere 
with glyphs on the next line. Sometimes, however, this is a desired effect, such as 
instances when vertical bars must connect from one line to another (for example, 
borders). In this case use the Safe zone top and bottom values described below. 

You can use ascender and descender to control the UPM size in which your glyphs 
are drawn. Fontographer’s default values are: ascender 800 and descender -200. 
You may change these proportions as needed. The default values provide UPM 
size of 1000 units. 

Line gap 

Line gap (or leading) is the space between the descender of the previous line of 
text and the ascender of the next line of text. It specifies how much space there is 
between lines. The term leading comes from earlier days when thin strips of lead 
were inserted between lines of text to provide line-to-line spacing. Currently, some 
applications ignore this line gap value.  Fontographer’s default value for line gap is 
20% of the UPM value. Line gap size is not used directly by a PostScript font but is 
used by Fontographer when calculating the default leading for bitmap generation. 

 

Line gap is the space between the descender of the previous line and the ascender 
of the following line. 



Fontographer 5 

24 

Safe zone top and bottom 

In addition to the ascender, descender and line gap values, there is another pair of 
vertical font metrics: safe zone top and safe zone bottom lines. 

Safe zone top is the line above which glyphs can be cropped (clipped, trimmed) in 
some applications. Safe zone bottom line — the line below which glyphs can be 
cropped. Some text layout systems lay out text so that the safe zone bottom of one 
line of text is immediately followed by the safe zone top of the next line of text. 
Any glyphs that go beyond those lines will be either cropped in Windows GDI 
applications, or will be squeezed in Mac OS Classic applications. Therefore the 
distance between those lines is called "safe zone". 

These values  are calculated automatically by Fontographer in most cases. 

! Note: Safe zone top, ascender, descender, line gap, safe zone bottom are 
linespacing values, so they should ideally be consistent for all fonts in the font 
family. In OpenType fonts, the safe zone top value will always correspond to OS/2 
Win Ascent value and the safe zone bottom value will always correspond to OS/2 
Win Descent. In other words, the distance between OS/2 Win Ascent and OS/2 
Win Descent can be referred to as the safe zone. 

x-height 

The x-height marks the top of lowercase letters such as “x” and “o.” Fontographer 
does not create this automatically, but you can easily create one yourself in the 
guides layer. You can position it anywhere, since it is only a guideline you’re 
creating. 

Ü Tip: Faces with taller x-heights are generally perceived as larger and more 
readable than those with smaller x-heights. 
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Origin line 

The origin line of the em square is always at a horizontal location of zero: 

 

Baseline 

The baseline is the line upon which capital letters sit. When printing mixed fonts 
on a line, all the different fonts’ baselines line up with one another. The baseline 
position does not need to be explicitly specified, since it is always at a horizontal 
location of zero. 

Basepoint 

The ª-shape at the intersection of the origin line and baseline is the 
basepoint. 

 

This is a movable reference point for position measurements or as an aid to line 
up points. When you open a new glyph’s outline window (or display a new glyph in 
an existing window), the basepoint is positioned at location 0,0 – at the origin 
point of the em square. Fontographer allows you to change the basepoint to 
another location by selecting a point and then choosing Set Basepoint from the 
Point menu. 

Width 

Width is a movable vertical line that specifies the width of each glyph. When the 
printer (or screen cursor) draws glyphs on a line, the invisible origin line of the 
next glyph is placed on top of the imaginable width line of the printed glyph. 
Widths may be zero but cannot be negative. 

Origin line 
Baseline 
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The font window 
 

 

 

Fontographer’s font window displays all the glyphs that make up a font. You can 
scroll through the sequence of glyphs with the standard scroll bar to the right. 

The font window also has other standard features like close, grow, and zoom 
boxes. 

Directly below the title bar is an info bar that displays font-related information. In 
the View by pop-up you are given a list of the ways to view font labels. 

When you choose an item from the View by pop-up, you change the font labels 
within the font window display. There are twelve different types of font labels. The 
character mode shows the symbols for each glyph in the Latin alphabet, while the 
keystroke mode shows you the keys you type to access the glyphs. In some cases 
the glyph symbol and the keystroke may be different. 

You’ll find more detailed information about font labeling information in “Glyph 
slots” on page 28. 

You can see some of the codes used to name the selected glyph in the info bar 
displayed to the right of the View by pop-up: 

 

Title bar 

Fontographer’s title bar is at the top of the font window. The name of the font 
appears here. You can move the font window around the screen by clicking its title 
bar, holding down the mouse button, and dragging the window to a new location. 

Close box Zoom box 

Scroll 
bar 

Info bar 

Grow box 

Title bar Spotlight 
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Scroll bar 

Standard scroll bar is drawn along the right side of the window. By moving the 
scroll bar, the window may be scrolled up or down to show other glyphs. 

View by pop-up 

 

The View by pop-up provides twelve different ways to look at your glyphs. Each 
one can be selected to show a different kind of name in the font label. 

· Character displays the system character corresponding to each slot in the font 
window. 

· Keystroke displays the keyboard sequence used to access a glyph. 

· Unicode codepoint is a value assigned to a glyph based on an international 
numbering system with 16-bit numeric designations for each glyph in every 
language used (or planned for use) in electronic information systems. 

· Decimal code number is a number value assigned to a glyph based on a 
numbering system with a base of 10. 

· Hexadecimal code is based on a numbering system with a base of 16. 

· Octal code number is a number value assigned to a glyph based on a 
numbering system with a base of 8. 

· Width view of a glyph displays the glyph’s width in em units. 

· Left sidebearing shows the distance from the left edge of a glyph to its origin, 
in em units. 

· Right sidebearing displays the distance from the right edge of a glyph to its 
width line. 
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And when viewing Type 3 fonts: 

· Fill tint  shows you what percentage of black fills a glyph. A fill of 0 is white; a 
fill of 100 is black. 

· Stroke tint  lets you see the percentage of black in the stroked part of a glyph. 

· Stroke weight displays the weight of the glyph’s strokes in em units. 

Glyph slots 

Glyph slots are visible in the font window. glyph slots can show the glyph paths. 
The scroll bar can be used to display additional slots not currently shown. The font 
label above the slot displays the code or letters that represent the glyph. 

When the label is outlined, the outline window contains paths, a defined width, or 
a scan. When the label is blue, it means the glyph has been changed. 

   

Font labels display in one of several ways. Viewing by glyph shows the Macintosh 
standard representation of that ASCII glyph code in the font label, while viewing 
by keystroke shows the keystrokes you’ll need to press to type that glyph. Change 
view modes with the font window’s View by pop-up. 

 

Below, the Macintosh keystroke for "ellipsis" is shown. The font label displays the 
OPTION-; keyboard command that is needed to type it. 

 

In this example, the keyboard command is SHIFT-OPTION-5. 

 

For this glyph the keyboard command is SHIFT-OPTION-K. 

Font label 

Glyph slot 
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A slot containing two asterisks signifies specific things in each mode. In the 
character and keystroke mode, it means that you cannot access the glyph from the 
keyboard. In the width, and left and right sidebearing modes, the double-asterisks 
tell you that the glyph is undefined. In the fill tint, stroke, and stroke weight 
modes the double-asterisks mean that the glyph is either unfilled, unstroked, or 
empty (and therefore the glyph shows no weight in em units). 

 

With the character view, an empty, undefined glyph slot displays as two 
asterisks. 
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Opening windows 
When you are familiar with the font window, look more closely at the glyphs you 
see in this window. There are three possible windows from which to view each 
glyph. Each window gives a different perspective of the glyph. The one you’ll use 
the most often is likely to be the outline window, although you will also have uses 
for the metrics and bitmap windows. 

· The outline window is where you’ll do the most glyph editing. A glyph’s 
outline reveals its filled or unfilled shape bounded by paths and points. 

· The bitmap window contains a glyph image displayed in pixels. Changing this 
bitmapped image alters the screen font’s appearance. 

· The metrics window displays a filled glyph image and provides tools to modify 
kerning and spacing. 

Any window can be accessed either from the font window or from Fontographer’s 
Window menu. Fontographer lets you open several windows at once. The actual 
number depends on how much memory is available in your computer. 
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The outline window 

 

To open a glyph’s outline window: 

You can open the outline window in one of four ways: 

· Double-click the selected glyph. 

· Select the glyph and type COMMAND-Y. 

· Select the glyph and press the RETURN key. 
· Select the glyph and choose Open Outline Window from the Window menu. 

The outline window is where most editing will take place. At the top of the window 
you see the title bar, which contains the name of the font and the font’s glyph 
code. Beneath the title bar is the info bar, with the numeric coordinates of the 
cursor in relation to various objects or positions in the window. Each indicator 
represents a different distance, or the number of selected points, respectively. 

Surrounding the screen image to the right and along the lower edge of the window 
are the scroll bars, which operate as they do in other programs. Close and grow 
boxes also work in the standard way. 
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The info bar 

 

 

 

 
 
 
 
 
 
 
 
The info bar consists of a row of coordinate values displayed under the title bar. 
Each value represents the cursor’s coordinates on an x and y axis in relation to a 
particular object or position. 

For example, the first value lists the cursor’s distance from the glyph’s origin (in 
em units). As you move the cursor, the values change. This information can help if 
you use precise measurements in your drawings. 

Click the I icon in the lower left corner of the outline window (next to the lock 
icon) to display or hide the info bar. 

 

Difference in x and y 
between basepoint and 
current cursor location 

Difference in x and y 
between selected point and 
current cursor location 

Location of selected point 

Difference in x and y 
between selected point 
location and basepoint 

Number of points in 
current selection Current cursor location 

Number of points in glyph 
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Changing glyphs in the outline window 

Using the keyboard 

You can move to another glyph’s window by typing the desired glyph symbol on 
the keyboard. If you are moving from one outline window to another, the lock icon 
in the first window must be unlocked. 

Lock icon 

The lock icon is operated by clicking it or by pressing RETURN. This toggles the 
icon on or off. 

The lock appears black when the glyph is locked into position. This prevents the 
glyph in the outline window from changing in case another key is accidentally 
pressed. When the lock is locked, the numeric keypad can be used to switch tools 
in the tool palette. 

When the lock is white or unlocked, the outline window can be changed to another 
glyph’s outline window by typing the new glyph’s key. 

  

Click the lock icon to lock or unlock the window 

Using the View menu 

When any glyph is selected in an active font window, or when any outline window 
is open, you can choose Next glyph, COMMAND-], or Previous glyph, COMMAND-[, 
from the View menu to move forward or backward in the sequence. 

Path direction indicator 

The path direction indicator tells you the direction of any selected path. You can 
use this feature to make sure that the paths of any glyph you create or edit are 
drawn in the necessary alternating pattern, from the outside to the inside of a 
glyph, so that the glyph will print with an accurate fill display. The arrow will point 
to the left or to the right, to indicate either a counterclockwise or a clockwise 
orientation. Clicking this indicator changes the direction of a selected path. 
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The bitmap window 

 

Hand edit your bitmaps in the bitmap window. 

 

Click with the pencil tool. 

To open a bitmap window: 

There are three ways to open a window for a bitmap glyph: 

· Press and hold down the OPTION key while you double-click the desired glyph. 

· Select the glyph and type COMMAND-J. 
· Select the glyph and choose Open Bitmap Window from the Window menu. 
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The bitmap window shows how glyphs look as they appear on the screen. 
However, bitmaps aren’t normally used in printing your type or graphics, so time 
spent editing them will have no impact on the printed results. Therefore, tweaking 
and adjusting bitmaps may not be for you. 

Actually, advances in programs related to type production have almost made 
editing bitmaps unnecessary. If you use modern Apple and/or Microsoft systems 
that use outlines for screen display, you don’t need to spend time perfecting the 
look of the screen font. 

A title bar appears at the top of the bitmap window. The first element in the title 
bar is the point size, followed by the font name, and the glyph code and location of 
the bitmap being displayed. Directly underneath the title bar is the info bar, which 
includes the actual size view of the glyph, the cursor location, and the ascent, 
descent, offset, and width values for the glyph. To the right is the Recalculate 
from outline button, which allows you to recalculate the size and shape of the 
bitmap based on the dimensions of the outline. This gets rid of any changes you 
have made to the bitmap and makes it conform to the shape of the outline (any 
subsequent editing to the outline will affect the bitmap). 

In the lower left corner you will find the lock icon for allowing or preventing 
access to other glyphs with the type of a keystroke. When locked, the current 
glyph’s bitmap window is locked in place; when unlocked, the icon appears hollow 
and you can access other glyphs by typing their keystrokes. 

You have eight tools in the bitmap window: the straight line, hand, eraser, pencil, 
marquee, move tool, measuring tool, and the magnifying tool. 

 

These are explained in more detail in Chapter 4, “Altering Outlines”. 
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The metrics window 

 

To open the metrics window: 

There are three ways to open the metrics window: 

· Select a glyph in the font window and type COMMAND-K. 
· Select a glyph in the font window and then choose Open Metrics Window 

from the Window menu. 

· Type COMMAND-K to access the metrics window directly from the outline 
window. 

The metrics window is where you can make manual kerning and spacing changes 
to your font. You can change and view the kerning and spacing values manually, 
by moving the sidebearing and kerning lines on the text in the screen display, or 
by typing in metric values to the table below the screen. Available options from the 
Metrics menu are: Auto Space, Auto Kern, and Kerning Assistance and Metrics 
Assistance (for advanced metrics). 

The metrics window displays a standard title bar listing the font name. The scroll 
bars, close boxes, and grow boxes work in the usual way. Underneath the title bar 
you’ll find the info bar – including a textbox for typing in sample text (pairs of 
letters, words, or phrases) for kerning and spacing within the window. Clicking the 
Show kerning icon will show the text sample kerned; when it is deselected (light) 
the sample appears unkerned. 

   

Kerning is on  Kerning is off 

The Text link lets you display a text file in the textbox and in the window. The UP 
and DOWN ARROWS let you scroll through the file line by line, displaying its text in 
the window. 
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Adjust left and right sidebearings and kerning distances by adjusting guides. 

 

Or type the values in the spreadsheet area. 

The metrics spreadsheet below the typed letters shows you the numeric values for 
each glyph’s width, left and right sidebearings, as well as its kern distance. glyph 
width refers to the horizontal distance from the origin to the width line. 
Sidebearings are the distances from the left and right of the glyph outline to the 
horizontal boundaries of the glyph’s bounding box. For more information about 
the metrics window, refer to “The metrics window” in Chapter 6, “Metrics – 
Spacing and Kerning”. 
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